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Welcome to the latest edition of my monthly Final Cut Studio newsletter for April, 2007.

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key 
articles are posted on my website for your reference. All software references are to Final Cut 
Studio unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 145 
tutorials to help you get the most out of Final Cut!
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Getting Ready for NAB 2007

By now, unless you've been hiding under a rock, you've heard the news that Apple has a special event 
planned for Sunday, April 15, just before NAB starts. While they have traditionally used these events to roll 
out new versions of Final Cut, no one who knows is talking.

So, we just have to wait until then to find out. (Apple won't give me an advance clue -- they consider me: 
"Press." Deep sigh....) 

In addition to Apple , I'm looking forward to making some new announcements, too. Plus, I'll be attending 
the Final Cut Pro SuperMeet at the Venetian on April 18. I'd love to meet you there!

For those that can't attend this event, I'll send you an email to let you know what all our new 
announcements are about. We are very excited about what the future holds and are looking forward to 
telling you about it soon.

Also, we will have extensive coverage of whatever is new in the April issue of Edit Well, which should be 
released the week after NAB.

This issue is a bit shorter than the last two issues -- mainly because I didn't wait two months to write it, so 
my correspondence is a bit more current. And, second, because as I write this, NAB is in two weeks. I'm 
really interested in this year's show, and looking forward to seeing what's new. 

Personally, I think this year is going to be significant for the Final Cut community. If you're going to NAB, I 
look forward to seeing you there. See you at the SuperMeet! 

[ Go to Top. ] 

What's New This Month in Edit Well

Edit Well -- the Rich-Media Newsletter for Final Cut Studio, published by Peachpit Press, continues to 
fascinate me. We took our microphones to Europe to interview FCP user groups in England and Ireland. 
We also have a fascinating debate between Uli Plank and Graeme Nattress on the best way to upscale SD 
video. I learned a lot editing this article.

This month, we expanded our video tutorials on creating variable speed clips in Final Cut Pro. We made 
them more relevant and easier to watch.

The March issue tips the scale at 40 pages! Here's what you'll find in the current issue:

http://www.lafcpug.org/nab_2007.html


●     Audio interview with Vicki Parks-Murphy and Luke McManus, co-presidents of the Dublin, Ireland, 
Final Cut Pro User Group

●     Creating Variable Speed Clips -- including three video tutorials!
●     Creating Customized LiveType Effects
●     Power Editing Review
●     GPRM Partitioning in DVD Studio Pro
●     Upscaling an SD clip for HD
●     Audio interviews with Ron Kanter who's using FCP to create his documentary on new police for 

PBS, and Dale Komai, who created a documentary when he discover what was in a 40 year old 
shoe-box.

Edit Well contains Final Cut Studio video tutorials, audio interviews, techniques, keyboard shortcuts and 
tips that you just can't find anywhere else. In Edit Well, you don't just read about it.. you also watch and 
listen to it. And, at only $59 per year, this is a GREAT deal!

Click here to view the Table of Contents for March (550 KB).
Click here subscribe: www.peachpit.com/editwell.

Edit Well is the perfect compliment to this newsletter -- if you like my newsletter, you'll love Edit Well. (If 
you have any problems subscribing, send me an email.)

[ Go to Top. ] 

Understanding Fields in Final Cut Pro 

This article got it's start in an email from a reader asking why their still frames were "vibrating" on the TV 
set, but not on the computer screen. The answer lies in interlacing.

All NTSC and PAL video is interlaced.

A video clip is made up of frames, or individual distinct images (30 per second for NTSC and 25 per 
second for PAL). Each frame is composed of a series of horizontal lines. These horizontal lines are divided 
into two sets, called Fields, where the first field is composed of all the even-numbered lines, and the 
second field contains all the odd-numbered lines.

http://64.150.168.122/assets/editwell/ew10_toc.pdf
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Interlaced means that these two fields are not shown at the same time, but one after the other -- in the 
case of NSTC video, they are 1/60th of a second apart.

(Now I realize that there are other frame rates and that some video can be shot progressively, which 
means the contents of both Field 1 and 2 are shot at the same time. However, for this discussion, let's 
assume we are working with traditional interlaced video.)

The problem that interlacing creates is that it takes both fields to create a single image, but the two fields 
were not created at the same time -- they are actually 1/60th of a second different.

Now most of the time, this interlacing is not a problem -- in fact, we've been watching it on TV all our lives. 
Where things get weird, however, is when you create a still-frame from a frame containing lots of motion.

On your computer monitor, everything looks great. This is because your computer monitor displays all the 
lines in your image progressively -- that is, all at once from top to bottom. However, on your Aunt Martha's 
TV set, when that still frame pops-up, the image vibrates so badly that poor Aunt Martha has to lie down 
and recover from motion sickness.

The reason is that when you use Final Cut to create a still frame, it freezes BOTH fields, even though they 
are showing action which is 1/60th of a second different.

What we need is a way to see this interlacing -- that way we can decide if it's a problem. (This is also a 
REALLY good reason to buy a video monitor that is not an LCD or plasma display, because LCD and 
plasma monitors don't display interlacing properly, either.)

Fortunately, Final Cut Pro displays interlacing; if you know where to look.

When you look at a rapidly moving video image, like the one below, portions that are moving will look 
blurred.



However, if you change your View setting, in either the Viewer or the Canvas, to 100%...

... you'll see thin horizontal lines radiating off all moving objects in the frame. These horizontal lines are 
from the two different fields. And when they are wide apart, as they are in this example, the "vibration" 
you'll see in a still frame will be severe!

So, before you create a still frame, switch your View magnification to 100% and see if the interlace lines 
are visible. If they are, you should pick a different still frame.

To fix bad interlace artifacts, where the image is rapidly vibrating, you can apply Effects > Video Filters > 
Video > De-interlace to your still frame. However, deinterlacing a clip removes half the lines in an image 
which means that the vertical resolution of your image also gets cut in half; therefore, it will not look as 
sharp or detailed as the rest of your clip.

Interlacing is a fact of life for NTSC, PAL, and half of the HD formats (those ending with the letter "i"). The 



key is to find out whether your still frame has excessive interlace artifacts before you finalize your project, 
rather than trying to revive Aunt Martha on her couch.

If you want to learn more, here's a Wikipedia article you can read.

[ Go to Top. ] 

Free Plug-Ins from Noise Industries

When it comes to persistence and follow-up, nobody does it better than Niclas Bahn, of Noise Industries, 
makers of FX Factory.

First, if you haven't heard of FX Factory, click here to learn more.

Second, Noise Industries has released Freebie FxPack1, a new FxPack offering four free image treatment 
tools for Apple Final Cut Pro and Motion users. Idustrial Revolution used the Noise Industries FxFactory 
Pro plug-in manager to design and develop the Freebie FxPack1 plug-in package. You can download the 
Freebie FxPack1 here. 

Freebie FxPack1 Highlights

●     MultiSpace: Puts two inputs into true 3D space with global and independent XYZ translation and 
rotation. Planes can also intersect.

●     iSight Live!: Get a live input on your timeline in Motion and FCP. Very handy for picking a color off a 
client's brochure.

●     Rack Focus: Racks the blur from one input to the other with one parameter. Both blur values for 
each input can be set independently.

●     Opposites: Two-input parameter linking: move one left, the other goes right. Rotate one clockwise, 
the other one goes anticlockwise.

All of these require FXFactory running with the latest versions of Final Cut Pro (v. 5.1.2 or later).

If you haven't tried FXFactory, you are missing a treat. I've been reading what other Final Cut trainers have 
to say about the software and the word "awe-inspiring" is often used. I just installed it on my system and 
I'm looking forward to playing with it.

[ Go to Top. ] 

Thoughts on Archiving

One of the key issues facing all of us is how to archive our projects and resulting media. Here are some 
thoughts from several readers on this subject, responding to what I wrote a few months ago. 

Dave Blackham writes:

http://en.wikipedia.org/wiki/Interlacing
http://www.noiseindustries.com/products/fxfactory/index.html
http://r.vresp.com/?ZazilMediaGroup/53d730c475/875350/TEST/TEST
http://r.vresp.com/?ZazilMediaGroup/53d730c475/875350/TEST/TEST
http://larryjordan.biz/articles/lj_backup.html


I was until recently the Head of Operations for Granada [Television in] Bristol, [England] who 
has operated FCP since V1.25. I built a 60TB SAN in Bristol then a 142TB SAN supporting 
both SD and HD for ITV in London. All promos and other inter-show material is now 
produced on Final Cut Studio in ITV.

My purpose in writing is at Granada we built a completely tapeless infrastructure post ingest 
and I saw your item regarding archiving. A solution that worked for us was using a Sony 
SIT1 drive locally attached to a G-5 which was in turn attached to the SAN. (The SAIT 
seems not to have drivers allowing a FireWire switch connection to become part of the SAN 
network, hence the G-5.)

We used Retrospect to manage the back-ups which worked very well as it also had the 
ability to run other Disk-to-Disk backups and other scripts overnight when needed. Also 
Retrospect can back up, say, a single line of commentary in the middle of a back up rather 
than rewrite the entire back up data. 

The SAIT1 at 500Gb also has the ability to back up one HD 50 minute show, requiring about 
400GB including handles. I always reckon 108 minutes of media per 50 minute show based 
on 5 second handles and about 750 edits per hour as a rough rule of thumb. The SSIAD 
tapes are not cheap but the drive is about £4500 which is a lot less than an SR deck and 
also preserves the show in its component layered form for possible re-versioning later.

With Apple purchasing Proximity I'm sure more elegant back up systems will be forthcoming 
but as Retrospect is application-agnostic this solution worked for us with large SAN 
infrastructures.

Larry replies: Dave, sorry to have missing you on my UK tour. Thanks for sharing your solutions.

Gerret Warner writes:

We purchased the HVX200 last fall and have now shot hours and hours of footage--all in 
DVCPro-50--and have been very happy with footage. But archiving is a challenge.

Our answer has been to do the following:

1.  Two Lacie Rugged 120 GB drives on the road because they are bus driven and can 
be used with my G4 powerbook anywhere. Our (4) 8 GB P2 cards get dumped to 
them through the day.

2.  Two OWC 500 GB FW 800/400 drives to archive all P2 8GB cards in duplicate (the 
drives are cheap, light enough to take on the road, and have worked fine). Each night 
in the motel, I copy from the LaCie's to the larger OWC drives in duplicate. Then, 
once I'm home, footage is imported into FCP.

3.  After all that, you have 3 copies on drives: MXF files on each drive and Quicktime on 
the capture scratch drive.

It's time consuming and sometimes anxious work trying to be sure you don't blow away a 
card, but so far I've done that only once... in a too-long shooting day. They key has been to 
carefully catalog all footage as you go so you know you've got it on the drives.

The real challenge is long-term archiving. I'd love to hear recommendations on DLT, LTO or 
whatever else has been successful and dependable in the industry. There must be a lot of 



experience in the world of archiving critical data. I'm not sure I can wait for Blu-Ray data 
disks.

Larry replies: Gerret, long-term archiving is, for me, THE issue that needs to be solved in order for tapeless 
acquisition to really take off. While I am leaning toward an Exabyte tape-based technology, I haven't seen 
anything that provides the key criteria necessary for archiving:

●     Long media life
●     Multi-vendor support for hardware
●     Reasonably priced
●     Ability to connect easily without fear of interface obsolescence
●     Relatively simple operation

Archiving is the key technology, well, aside from whatever Apple is doing, that I'll be looking for this year at 
NAB.

And I agree with you that Blu-Ray, or any other brand-new optical disc technology, is not to be trusted for 
long-term archiving until it has been aggressively tested in the market for a couple of years.

Nicholas Karfoot adds one more opinion:

In one of your training videos, I forget which one now, You where talking about the P2 
system and the cons of backing up this sort of data. I just thought if you haven't already seen 
it that Grass valley have teemed up with Iomega to produce a system called RevPro a 35GB 
storage system. Check it out here. 

Larry replies: Nicholas, I had a chance to see this recently at the San Francisco Final Cut Pro User Group 
meeting. While it is small, portable, inexpensive, for me it doesn't meet the needs of video editors.

First, it doesn't hold enough. Second, it's too new to know what the life-span of the media is. Third, it's from 
the same folks that brought us SyQuest drives, Zip disks, and Jaz drives -- all were EXCELLENT in 
providing removable storage; but I can't access any of them today.

Don't confuse removable media with long-term storage. Just because we can pop the disc out of our 
system today doesn't mean we can put it back in five years from now.
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Special - Soundtrack Pro & Soundtrack Pro Audio Filter Training Videos

http://www.exabyte.com/products/products/get_products.cfm?prod_id=601#prices
http://www.thomsongrassvalley.com/products/infinity/rev_pro/


For the month of April, we are running a special promotion in our store -- 
buy both the Soundtrack Pro and SoundTrack Pro Audio Filters training 
videos for one low price: $134.00. Save 10%!

Here's what you'll learn about SoundTrack Pro.

And here's what you'll learn about Soundtrack Pro Audio Filters.

If you are looking for ways to make your audio sound better, these two 
titles can help.

Click here to order - remember, this special offer ends April 30, 2007.

[ Go to Top. ] 

A Free 50-point Garbage Matte

Tom Henderson has written a neat little plug-in (well, actually, he wrote it a while ago, I just recently 
discovered it) that creates up to a 50-point garbage matte.

If you don't know what a garbage matte is, this article can help.

The plug-in is free and you can learn more about it here.

[ Go to Top. ] 

More FXPlug-Ins

John Ramsden, from the BBC London, writes in with more FXPlug-ins:

Larry, regarding your comments on trying to get a smooth credit roll, here's an inexpensive 
plug-in that's the only way I've found to get a really smooth roller and it has many features I 
never used, I think different font sizes is one of them. It's made by CHV-Electronics:http://
www.chv-plugins.com/
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Capturing Video From an iSight

Pons Maar provides the following tip:

http://www.larryjordan.biz/cgi-bin/ecommerce/ac/agora.cgi?p_id=00049
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QuickTime Pro offers an alternative that I saw on the Apple OSX tips page. You can capture 
video from an iSight either using H.264 compressed or a device native full resolution 
version. And, its incredibly easy. 

1) Hook up your camera via FireWire.
2) Select QuickTime > File > New Movie Recording. A window will open showing your image 
so you can tweak your camera settings and lighting, then just hit the red button and you are 
recording live.

Using the QuickTime > Preferences > Recording tab you can set your video and audio 
source, quality and where to save the files.



The advantage of this is that I don’t have to open Final Cut Pro, I can use my PreSonus 
Firebox as my audio in and have more control over the audio input than through my camera, 
and I have a real time preview as I’m shooting.

For a home studio you can get a 32’ firewire cable, run it from the camera to your computer 
and you have a direct to disk recording set up...pretty sweet. Obviously if you have a laptop 
then you have the same possibility but with portability.

Larry replies: Pons, this is a great tip. One caution, though. FireWire has a cable limit of 15' -- longer cables 



require amplifiers to make sure your signal arrives safely. Otherwise, you run the risk of signal degradation. 

[ Go to Top. ] 

Thoughts on Business

Joseph Matthews, with the VA Puget Sound Health Care System, writes:

As a photographer transitioning into video your newsletter is very very helpful. I really 
appreciate it. I just wanted to add this advice to the "what should I get first" question.

Starting out is hard. Treat it like a business and think in terms of business investments. 
Before you finish the wish list, find an accountant/tax prep person that you can trust for 
advice. You may need to get a local or state business license. But the IRS will help you pay 
for your equipment with accelerated depreciation and reducing your tax liability. Your 
accountant will tell you what qualifies and how you will need to proceed to protect your tax 
status (% of income from video production, etc). The IRS will even cut you some slack and 
expect you not to make a profit for a couple of years.

Don't think that you need to pay cash up front for the first equipment, buying on credit or 
maybe a lease would be better. I know at least one person that set up a studio on one credit 
card (that gave airline miles) and then moved the entire balance a couple of months later to 
a 0% transfer offer. Save the on-hand cash for daily costs.

Larry replies: Joe, this is really great advice. One of the things we learned from our recent business survey 
is that there is a significant need for business training for Final Cut editors. One of the announcements we'll 
be making at NAB is a series of web-based seminars helping editors learn how to grow their business. 

We'll be making a formal announcement about this new seminar in a couple of weeks.

[ Go to Top. ] 

New Products List on our Website

Thinking of new announcements, we are adding a new feature to our website (www.larryjordan.biz) to 
present new product announcements related to Final Cut Studio.

Rolling out later this spring, this section will make it easy to learn what's new in the Final Cut community.

If you have a product you'd like us to mention, please send us your information, suitable for posting, and 
we'll make sure to list it.

There's no charge for this service.

[ Go to Top. ] 
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Getting Sleeping Disks to Stop Sleeping

Here's an exchange between Bruce McCoy and myself regarding an earlier review of LaCie's D2 hard 
drive where I faulted it for sleeping when I didn't want it to sleep.

Bruce writes:

As I was reading your newsletter this month, I was puzzled by something that you wrote in 
your LaCie d2 Quadra hard disk review. You stated that "For the last year, I've been using a 
G-Tech drive that never spins down."...hold it right there! ...I have a 1TB G-Tech RAID and a 
400GB G-Tech RAID, both of which exhibit the behavior that drove you nuts with the LaCie. 
My Energy Saver settings are the same as your example.

Any thoughts as to why mine sleep and yours doesn't.

Larry replied: My first reaction is that you have a RAID and I have a single disk. Other than that, I don't 
have any idea.

Bruce responded: 

Yesterday after our communique, my obsessive-compulsive nature kicked in and I found this:

http://www.macmaps.com/Macosxspeed.html

Select: #21 Hard Drive Spindown which will take you to a script that will keep the disks from 
spinning down. It seems to work just fine, although there is probably a down side that will 
hopefully not appear mid session with a hovering client. I have not loaded it in my startup 
items yet until I do a little more testing.

Larry replies: Thanks for tracking this down. Keep in mind that I haven't tested this, so be careful in using 
this in your system.

[ Go to Top. ] 

Getting Effects to Move Faster

Steve MacDonald wrote in with a problem:

I've tried to figure this one out on my own with no luck what so ever, so I thought I would 
pass this to the more experienced. The subject is the speed of a motion path within FCP. 
Let's say I want to make a motion path move very quickly, yet stay within the 720 X 480 
video frame. The bezier speed bump control won't even come close to moving an object as 
fast as I'd like it. The only way I can make that happen is if I have a motion path that is 
beyond the 720 X 480 video frame which places the speed bumps father apart for a faster 

http://www.macmaps.com/Macosxspeed.html


motion path. Please tell me the Motion tab can accomplish this task, please! 

Larry replies: Steve, not to panic. 

The speed of a motion effect is determined by how far apart the key frames are and how far the object 
moves. To speed something up, move the keyframes closer together. The acceleration dot can be useful, 
but moving the keyframes is much more useful.

Steve tried this, then sent this update:

You're the man! Here's how I now do this. First, I determine where I want my motion object 
to end and place it at it's final position, then add a motion keyframe in the canvas. Now I 
place my playhead at the first frame of the clip, shrink the canvas view to 25%, and drag the 
clip way off the frame to get the acceleration bumps far apart. Then I do what you told me, I 
move the start keyframe closer to the end keyframe so the effect starts within the 720 x 480 
video frame and voila!

Larry replies: Happy to help.
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Be Careful of Too Many Sequences

Jack Freidog sent me the following:

I was having lots of problems opening sequences in Final Cut's timeline (using version 
5.1.4). After a lot of hair-pulling and calls to Apple, I figured out that I had too many 
sequences, around 65 or more. Apparently FCP doesn't like to keep all those sequences in 
memory. I deleted most of them, keeping only around 15. I restarted and poof... I was up 
and running again. Thanks for your help.

Larry replies: Jack, this is a good tip. Sequences take memory. Too many sequences will fill your memory 
and cause problems. Thanks for sharing this.

[ Go to Top. ] 

File Naming Conventions

Marla Mitchnick sent me an email asking if I'd written an article on file naming conventions that she could 
refer to. so, I went to my library and discovered that I haven't written anything about this.

So, rather than just talk about what I use, I'm researching an article on file-naming conventions for editing 
and I'd like to know what system you use to keep track of all your files.

Send me an email illustrating your system. I'll turn everyone's suggestions into an article and share it with 



all of us.

Thanks -- send your email here.

[ Go to Top. ] 

Reader Mail

We have a fair amount of reader mail this month. As always, please send me your comments, questions, 
or opinions. I love reading them and sharing them with other readers.

[ Go to Top. ] 

A Disk Journaling Tip

Adam Connell writes:

I would like to describe a scenario I recently encountered with journaling on media drives 
with Final Cut Pro 5. 

I recently got a MacBook Pro 2.33 Core 2 Duo, 2GB RAM, etc., and fixed it up with Final Cut 
Studio 5 and an external FireWire 800 drive (The machine would be better with 2x FW 400s 
in my opinion). When playing back a simple sequence of just a few 'freeze frames' before my 
main edit, I received some dropped frames on playback. In trying to diagnose the problem I 
created a few scenarios on my sequence, and found that FCP dropped frames on playback 
of a sequence in very simple parts of this MiniDV standard def edit, even in areas which I 
had rendered. 

After reading your page about journaling I decided to re format the external drive with 
journaling turned off. After replaying these sequences, obviously I had to re render them, 
suddenly there were no more hassles, and realtime performance was greatly increased.

Larry replies: Adam, turning Journaling off probably helped. But, what helped even more was reformatting 
your drive. Most often, but not always, dropped frames are caused by a hard disk that can't keep up with 
the video stream. Reformatting reset everything on the hard drive so that it could work at maximum speed.

Here's an article that provides more trouble-shooting tips.

[ Go to Top. ] 

Exporting From Livetype to PowerPoint

Alan Bergstein writes:

mailto:larry@larryjordan.biz?subject=File Naming Conventions
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Now you've done it again - gotten me so excited about this stuff that I just want to use it 
everywhere. 

What's the chance that I can create some work inside of LiveType 2.0 and bring it into 
Powerpoint to razzle and dazzle my clients? I read somewhere that you can do this with 
Apple's Keynote, so I'm wondering if you can suggest how to do it within Powerpoint so that 
my unfortunate non-mac clients can also see the work.

Thanks very much and keep up the good training. You're a great teacher!

Larry replies: Alan, thanks for the kind words. You can save your Livetype project as a QuickTime movie by 
selecting File > Render within Livetype.

[ Go to Top. ] 

Creating Chapter Markers in H.264 Video

Pieter Dekkers, from the BCIT Learning and Teaching Centre, writes:

Thanks for your newsletter. It is, as always, a great resource and also a good confirmation 
that I am not the only one who is sometimes struggling just trying to keep up.

I have a question for you:

In my work I get more demands for Podcasts/Video-Casts. Sometimes it involves lectures 
(audio and video) up till about 45 minutes.

I have experimented with various compression settings with very good results. I am quite 
happy with Quicktime Conversion > MPEG-4 > H.264 compression and managed to get the 
file sizes to an acceptable minimum. However when I try to add chapter markers using FCP, 
I have some issues: the chapter markers do not come across in various experiments. 

The easiest way of doing it is using Garageband. However the files are huge. I am trying to 
figure out which settings Garageband is using (It must be using the same compression 
engine as Quicktime-Pro/FCP/Compressor) and next I hope to lower the data rate/frame rate 
etc. Any advice? Other ways of doing this, through Cleaner for instance? 

Larry replies: Pieter, there's no need to use GarageBand, the problem is how you are exporting the file. 
When you export your file using File > Export > QuickTime Conversion, the chapter markers are 
removed. If you export your file using File > Export > QuickTime Movie, and set the Markers pop-up to 
DVD Studio Pro Markers, all your markers are retained.

Using Compressor you can compress the file into an H.264 QuickTime movie.

[ Go to Top. ] 



Working with DVCPROHD

Ben Balser and I have been having an on-going dialog about the value of DVCPROHD. And, in fact, I am 
working on an article for Edit Well later this spring comparing a variety of high-end video codecs. However, 
while that article is being written, Chris Cummings sent me the following:

Hope all's well...just came across this interview with Chris Watts (VFX Supervisor on 300) 
who had some very interesting things to say about the DVCProHD codec that he learned 
from Apple (it's just before the midpoint of the article):

http://digitalcontentproducer.com/hdhdv/depth/300_hd_pipeline_03272007/

Excerpt:
“We shot on film. We transferred all of the film to basically three flavors of media—two of 
them HD,” Watts recently told HD Focus. “The first was just regular old Avid [disk-based] 
media. The second was HDCAM-SR tape, and the third was HD res QuickTime, using the 
DVCPRO HD codec. For whatever reason, it’s supposed to be like a 60i codec, but it 
actually works great at 24p. It’s kind of a weird hack. Somebody at Apple told us about it.

“Essentially, it makes a 1920x1080 QuickTime that will play back at that res. Instead of 
playing back at 1080i, it plays back at 1080p—24p. It works great. It’s pretty low data rate. 
It’s about 100 megabits, and it color corrects great. It looks great. There are no ugly 
temporal artifacts. It’s purely a spatial codec, so you can edit with it. It’s a really great thing.”

Larry replies: Chris, this is great information. Choosing the right codec for your project is getting harder and 
harder with the proliferation of cameras, codecs, and formats. Thanks for sharing this.

[ Go to Top. ] 

Exporting DVCPROHD Stills

Thinking about DVCPROHD, in a recent dialog between two Apple trainers, I learned the following.

Problem: A student recently tried to export some DVCPROHD 720p 24-fps stills from a 16:9 
Sequence in FCP, but they keep getting exported with a 4:3 aspect ratio. What does it take 
to get this to be it's normal 16:9 size?

Answer: Exporting to stills always uses the native size of the media, which for DVCPROHD 
is 960x720 (4:3). The workaround is to export the stills, then set up a still-image preset in 
Compressor and set the aspect ratio to convert it to 16:9 there. 

[ Go to Top. ] 

Converting Slides

http://digitalcontentproducer.com/hdhdv/depth/300_hd_pipeline_03272007/


Bob Avery writes:

I have a bunch of old slides. What is the best way to convert them to stills for PhotoShop or 
to use in Final Cut?

Larry replies: The best way is a slide scanner - either Microtek -- or Nikon make excellent ones.

Create a high-resolution (300 dpi) TIFF of your image for archiving, then reduce the size in PhotoShop for 
your video projects. Here's an article you can use to determine image sizes.

[ Go to Top. ] 

Reader Help Needed

Jay Moy writes in with a question:

I'm trying to capture from a Canon MV890 camera. When my external drive is connected, I 
can not capture footage, but I can control the deck and see timecode. The deck is connected 
via FireWire into the back of a 500GB G-Tech drive which is connected into a 17" MacBook 
Pro via firewire 800. The problem is the same if I connect the camera into the firewire 400 
port on the mac - when the external drive is connected i cannot capture footage, but i can 
control the deck and see the timecode.

Larry replies: Jay, I have no idea. If any readers can suggest a solution, I'll pass it on to everyone.

[ Go to Top. ] 

32-bit Floating Point Audio

John Gallagher writes:

Just saw something (fairly minor) in FCP 5.1.2 that confused me a bit. It concerns the audio 
format of sequences. No matter what the audio format of a sequence, it shows up as "32 bit 
floating point" in the Audio format column in the Browser. Presumably this is because the 
program works internally to a 32 bit depth to maintain as much info as possible. Still, it's a bit 
misleading to show this in the audio format column, if you ask me. It's a "gotcha" that might 
catch some people out, so it may be worth including in the next newsletter? What do you 
think?

Larry replies: John, 32-bit floating point is a good thing -- and a recent addition to Final Cut Pro. What this 
means is that regardless of what audio you bring into your sequence, FCP will do all it's audio calculations 
at 32-bit. 

As the FCP Manual explains (pg. III-72):

http://www.microtekusa.com/as4000tf.html
http://www.nikonimaging.com/global/products/scanner/scoolscan_4000/index.htm
http://www.larryjordan.biz/articles/lj_grfx_look.html


Final Cut Pro mixes audio internally at 32-bit floating-point resolution, which is a much higher 
resolution than the 16- or 24-bit audio you are using in your project. This allows audio 
calculations, such as fader levels and effects processing, to be performed at very high 
resolution with a minimum of error, which preserves the quality of your digital audio. The 
internal mixing resolution allows Final Cut Pro to mix with an enormous amount of additional 
headroom. This lets you mix many audio channels together without clipping internally.

[ Go to Top. ] 

Another Tip on Audio Levels

John Gallagher just has too much time on his hands, because he sent in another audio tip:

If you select a range of audio clips on the timeline and press Command+Option+L you can 
set the gain of all of them in one fell swoop. Just type in the gain and alter the "Make 
Changes" drop-down to "Absolute". So what's the benefit compared to copying and pasting 
the audio level attribute from one clip to the rest? Well, it's quicker and easier (at least I think 
so), but best of all you can make relative changes to each audio clip level - boost all your 
clips whilst retaining the differences between them! Not one to stop there, I tried it on Video 
clips and it can be used to adjust the Opacity in the same way. Very handy.

Larry replies: John, if you set the Levels menu to Absolute, all clips will be set to the same level. If it is set 
to Relative, the clips will adjust their level by the amount you entered, relative to their original audio level.

Here's an article that explains this a bit more: http://www.larryjordan.biz/articles/lj_audio_levels.html.

[ Go to Top. ] 

Wrap-up

Well, that's it for another issue. Please take a few minutes and:

●     Subscribe to Edit Well
●     Visit our store and buy a DVD, or two. 
●     And send me the latest on your new products 

Your support for our seminars and products keeps our website, and this newsletter, free. 

Thanks for all your comments and questions. I love hearing from you because when you share your ideas 
and suggestions, we all learn.

Until next month, take care, and edit well.

Larry

http://www.larryjordan.biz/articles/lj_audio_levels.html
http://www.peachpit.com/editwell
http://64.150.168.122/store/index.html
mailto:larry@larryjordan.biz?subject=New Product Announcement
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at www.
larryjordan.biz.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, rented, or 
bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However, due to the 
variety of possible system and software configurations, the author assumes no liability in case things go 
wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not been 
reviewed or sanctioned by Apple or any other third party. All trademarks are the property of their respective 
owners and are mentioned here for editorial purposes only.

Text copyright 2007 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without specific written permission from the author. 

Links to my website home page or articles are welcome and don't require prior permission. 
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